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About This Mac
Software Update...

App Store...

System Preferences...

Dock =
Recent Items B

Force Quit Finder X {#D

Sleep \¥a
Restart...

Shut Down...

Log Out admin... ¢ #Q

Monday, February 21, 2011
Choose System Preferences from the Apple menu
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Monday, February 21, 2011

Click on Accounts



My Account

Other Accounts

Cuest Account
Login, Sharing

[ Password | Login Items ! .

ﬁ Login Options

+

@ Click the lock to make changes. @

m (' Change Password... )

Full Name: admin ‘

MobileMe user name: [ Set.. )

Address Book Card: (  Open... )

V' Allow user to administer this computer

__| Enable parental controls ( Open Parental Controls... )

Monday, February 21, 2011

Click on the little padlock on lower left side



Type your password to allow System

Inl Preferences to make changes.

Name: admin

Password:

b Details

@ ( Cancel ) E—OK—)

Monday, February 21, 2011
Put in the admin username and password and click OK to unlock



Other Accounts m ( Change Password... )
Cuest Account

Login, Sharing

Full Name: admin }

MobileMe user name: [ Set.. )

Address Book Card: (  Open... )

V' Allow user to administer this computer

| Enable parental controls ( Open Parental Controls... )

G} Login Options

-

]f‘ Click the lock to prevent further changes. @

Monday, February 21, 2011
Click on the + sign



4>
-

New Account: ' Standard

Full Name: teacherl

Account name: teacherl

Password: eseeseee ?

Verify: sscsessse

Password hint:
{Recommended)

I Turn on FileVault protection

@ ( Cancel :: ( Create Account )

Monday, February 21, 2011

Enter a username and password you’d like to use for this account. Normally | do all my work
in a standard account and only use the administrator account to install software or do other
administrative task. Better security this way.

Click Create Account. If you see a message onscreen about automatic login, click Keep
automatic login.



®oo Accounts
<|» | [ ShowAll ‘Q )

My Account

admin
Admin
Other Accounts

4 teacherl S
I Standard

C oS ReES ot ™ Allow guests to log in to this computer
Login, Sharing Enable the guest account so that friends can temporarily log in to
your computer. Logging in to the guest account does not require a

password. Users cannot log in to the guest account remotely.

When a guest user logs out, all information and files in the
guest account's home folder are deleted.

__| Enable parental controls ( Open Parental Controls... )

™ Allow guests to connect to shared folders

Q Login Options

+ | -

dh Click the lock to prevent further changes. @

Monday, February 21, 2011
Click on Guest account. Tick Allow guests to log in to this computer.

This is good for occasional users and for computer labs because everything you do will be
wiped when you log out.



i 8e0o Accounts
> Show All

My Account
admin Automatic login v Off
Admin ‘

Other Accounts admin

Eole oot
-, teacherl Dispiay lagin'g teacherl g

Standard Cuest Account
Cuest Account ‘WJ
8 Show the Restart, Sleep, and Shut Down buttons

Login, Sharing
! Show input menu in login window

B Show password hints

| Use VoiceOver in the login window

|| Show fast user switching menu as: " Name 4]

Network Account Server:

ﬁ Login Options

.|

@ Click the lock to prevent further changes. @

Monday, February 21, 2011

Click Login Options

From the Automatic Login popup choose either your account of the guest account.



Automatically log in as: | teacherl v

Password: |

( Cancel ) f—Ok—a

Monday, February 21, 2011
You’ll need to put in the password and click OK



My Account

admin ) -
Admin Automatic login: [teacherl ﬂ

Other Accounts

“+ teacherl
Standard

Cuest Account
Login, Sharing

Display login window as: () List of users

() Name and password
™ Show the Restart, Sleep, and Shut Down buttons
| Show input menu in login window
™ Show password hints

| Use VoiceOver in the login window

4>

| Show fast user switching menu as: ( Name

Network Account Server:

@ Login Options

T -

dﬁ Click the lock to prevent further changes. @

Monday, February 21, 2011
Here, the computer is set up to log directly into the teacherl account.



®onn Accounts

My Account

admin ) -
Admin | Automatic login: [ teacherl “q

Other Accounts
Display login window as: () List of users
4+ teacherl

Standard O Name and password

Cuest Account

Login, Sharing ™ Show the Restart, Sleep, and Shut Down buttons

|| Show input menu in login window
8 Show password hints

| Use VoiceOver in the login window

™ Show fast user switching menu as: [ Name M

Network Account Server:

@ Login Options

T -

l{h Click the lock to prevent further changes. @

Monday, February 21, 2011
Click Show fast user switching menu, this enables you to quickly switch to another account.
Click Show All.



Configure Mouse or
Trackpad

1111111111111111111111



File Edit View

About This Mac
Software Update...
App Store...

System Preferences...
Dock
Location

vv

Monday, February 21, 2011
If System Preferences was not open, open it
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System
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Desktop &
Screen Saver
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Controls
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Sharing

Software
Update

g e Q@

Language & Security Spotlight
Text
Mouse Trackpad Print & Fax Sound

)

Speech Startup Disk Time Machine  Universal
Access

Monday, February 21, 2011

Choose Mouse or Trackpad depending on what you have



Tracking Scrolling

| I I I I | I I I I | | | I I I I I
Slow Fast Slow Fast

Double-Click

LSRG st S N st ] S ] S [ |
Slow Fast

One Finger
| Secondary click (Right #)
™ Scroll ( with momentum $)

aScreen Zoom | Options... )

Two Fingers
M Swipe Left/Right to Navigate

Mouse battery level: @] 100%

Monday, February 21, 2011

If using a mouse, change Tracking to Fast and make sure Secondary click is set.



®oon Trackpad

Tracking Speed Double-Click Speed Scrolling Speed
I | I I I I | I | I S T B | G s | B S et A e | = | | I | | I | | I I I
Slow Fast Slow Fast Slow Fast
One Finger
ETap to Click
BDragging

__| Drag Lock
™ Secondary Click ( Bottom Right Corner +)

Two Fingers

8 Scroll

B Rotate

8 Pinch Open & Close

M Screen Zoom ( Options... )
8 Secondary Tap

Three Fingers
v Swipe to Navigate

Four Fingers
™ Swipe Up/Down for Exposé

B Swipe Left/Right to Switch Applications

Monday, February 21, 2011

If using a Trackpad, change Tracking Speed to fast and make sure Tap to click is set. | prefer
to tap with two fingers for Secondary click.



Mouse Basics
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Finder

Monday, February 21, 2011

t T 4 (5} Mon 256 PM  teacherl

o Mac 08 X stk OVO
C) oo“
| ARID

— MaraCapeule

B Oeshrop

N\ apei <abons

DoCurrants

SEARCH FON
Today
Yesterday
Paae Week

. Alimage

;‘; Al Nowvies

Documents

9 e, 124,52 GB avaslatle

Downioads

| -

Pictures

Click the Finder (lower left) to open a Finder window



About Stacks.pdf

Monday, February 21, 2011
Double click Documents to open the Documents folder



1 T 4 (ZF Mon 257 PM  teacherl Q

. »

YOS
2 Macmesh HD
L Mac O X el OVD
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G AT Movea
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Monday, February 21, 2011

Drag about Stacks to the Desktop



Open
Open With

Move to Trash

Cet Info

Compress “About Stacks.pdf”
Burn “About Stacks.pdf” to Disc...
Duplicate

Make Alias

Quick Look "About Stacks.pdf”

Copy "About Stacks.pdf”

Clean Up Selection
Show View Options

Monday, February 21, 2011
Right-click on About Stacks to show the contextual menu



New Folder

Cet Info

Change Desktop Background...
Clean Up

Arrange By b
Show View Options

Monday, February 21, 2011

Right-click on Desktop to change Desktop pattern



Create New Folder
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New Folder

Cet Info

Change Desktop Background...
Arrange By B
Show View Options

Monday, February 21, 2011

Right-click on Desktop, choose New Folder



: untltl folder

N .

Monday, February 21, 2011
You can type in the name immediately, no need to delete the existing text first



Monday, February 21, 2011
After you type in the new name, my stuff, press Return



Monday, February 21, 2011
Done. To change the name again press return, and repeat the process.



E Macintosh HD
=} Mac 05 X Install DVD

£ ibisk

¥ SHARED
— MaraCapsule

¥ PLACES
FA Desktop

&8 teacherl

ﬁ Applications
@ Documents

¥ SEARCH FOR
() Today
(L) Yesterday
() Past Week
All Images
All Movies

Monday, February 21, 2011
Double-click the newly created folder to open it.



a Macintosh HD
=} Mac 05 X Install DVD

£ ibisk

¥ SHARED
—J MaraCapsule

lesson plans

¥ PLACES
Desktop

&8 teacherl

ﬁ Applications
@ Documents

¥ SEARCH FOR
() Today
(L) Yesterday
() Past Week
All Images
All Movies

Monday, February 21, 2011
Create a new folder inside it called lesson plans.



Copy Files
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Monday, February 21, 2011
Click on the Finder in the dock to open a new Finder window



& Macintosh HD

S

=} Mac 05 X Install DVD
£ ibisk

¥ SHARED
— MaraCapsule

¥ PLACES
FA Desktop

&8 teacherl

ﬁ Applications
@ Documents

¥ SEARCH FOR
() Today
(L) Yesterday
() Past Week
All Images
All Movies

Monday, February 21, 2011
Click on Macintosh HD to show the contents



ga | = RINA (m|

33 Applications
Library
System

(4] Users

. hs ud i ‘a

Monday, February 21, 2011
Choose Column View
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¥ DEVICES
f—i Macintosh HD

! Mac OS X Install DVD
E ibisk

¥ SHARED
— MaraCapsule

¥ PLACES

E Desktop
ﬁ} teacherl

ﬁ Applications
@ Documents

¥ SEARCH FOR
(L) Today
(L) Yesterday
(L) Past Week
All Images
All Movies
All Documents

—

el e s
JeskKtop Fictures

et A ~hl

[ =fm] (o [

Applications
Library
System
Users

—

Application Support
Audio

Caches
ColorPickers
ColorSync
Components
Compositions
Contextual Menu Items
Desktop Pictures
Developer
Dictionaries
Documentation
Extensions
Filesystems

Fonts

Frameworks
Craphics

Image Capture
Input Methods
Internet Plug-Ins

¥ v¥Vv¥v¥v¥v¥v¥v¥ vV v vV vy vV VvV vV VYV Y Y Y

Abstract

= Aqua Blue.jpg
= Aqua Craphite.jpg

Art
Black & White

®m Classic Aqua Blue.jpg
m Classic Aqg...raphite.jpg
=1 Flow 1.jpg

= Flow 2.jpg

= Flow 3.jpg

= Jaguar Aqua Blue.jpg
= Jaguar Aqua Graphite.jpg
= Lines Blue.jpg

= Lines Graphite.jpg

= Lines Moss.jpg

= Lines Plum.jpg

Nature

= Panther Aqua Blue.jpg
= Panther Aq...raphite.jpg

Patterns
Plants
Ripples Blue.jpg

Monday, February 21, 2011

Click Library -> Desktop Pictures




¥ DEVICES

2} Mac OS X Install DVD
El iDisk

¥ SHARED
L MaraCapsule

¥ PLACES
E Desktop
{;’} teacherl
#\ Applications
" Documents

¥ SEARCH FOR
‘\;/I Tway
(~) Yesterday

(~) Past Week

All Images
(4] All Movies

.| Nature

O |3~

(] Application Support
(] Audio

() Caches

(] ColorPickers

(] ColorSync

(] Components

(L] Compositions

(] Contextual Menu Items
|| Desktop Pictures
(] Developer

(] Dictionaries

(] Documentation

(] Extensions

[ Filesystems

(] Fonts

(] Frameworks

(i Graphics

(] Image Capture

(] Input Methods

(] Abstract
= Aqua Blue.jpg
= Aqua Graphite.jpg
& Art
(] Black & White
m (Classic Aqua Blue.jpg
®m Classic Ag...raphite.jpg
Flow 1.jpg
Flow 2.jpg
' Flow 3.jpg
Jaguar Aqua Blue.jpg
Jaguar Aqua Graphite.jpg
Lines Blue.jpg
Lines Graphite.jpg
Lines Moss.jpg
Lines Plum.jpg
[ Nature
= Panther Aqua Blue.jpg
= Panther Aq...raphite.jpg

* [ Patterns
v
" (] Plants

(] Internet Plug-Ins
(] iTunes
| -

(] All Documents

memsmeyRmEDenEegreseDER

Aurora.jpg
Cirques.jpg

Clown Fish.jpg
Dew Drop.jpg
Earth Horizon.jpg
Earth.jpg

Evening Reflections.jpg
Flowing Rock.jpg
Gentle Rapids.jpg
Golden Palace.jpg
Horizon.jpg
Iceberq.jpg
Ladybug.jpg
Leopard Aurora.jpg
Pond Reeds.jpg
Rock Garden.jpg
Rocks.jpg

Snow Leopard Prowl.jpg
Snow Leopard.jpg
Snowy Hills.jpg
Stones.jpg

26 items, 124.76 GB available

my stuft

Monday, February 21, 2011

Drag Nature and Plants to the my stuff folder




E Macintosh HD
=} Mac 05 X Install DVD

£ ibisk

¥ SHARED
— MaraCapsule

lesson plans Nature Plants

¥ PLACES
FA Desktop

&8 teacherl

ﬁ Applications
@ Documents

¥ SEARCH FOR
() Today
(L) Yesterday
() Past Week
All Images
All Movies

Monday, February 21, 2011
open my stuff

you should see lesson plans, nature and plants in there



Date Modified

Today, 3:11 PM

Dec 18, 2010 10:29 PM
Jul 28, 2009 1:18 PM

a Macintosh HD
.~ Mac OS X Install DVD

£ ibisk

¥ SHARED
— MaraCapsule

¥ PLACES
E Desktop

&8 teacherl

ﬁ Applications
Documents

¥ SEARCH FOR
() Today
(L) Yesterday
() Past Week
All Images
All Movies

Monday, February 21, 2011
Click on List view button

This is most like Windows Explorer



¥ DEVICES
| Macintosh HD

.~} Mac OS X Install DVD
E iDisk

¥ SHARED
— MaraCapsule

¥ PLACES
Desktop
@ teacherl

ﬁ Applications
@ Documents

¥ SEARCH FOR
(L) Today
(1) Yesterday
() Past Week

All Images
All Movies

_—

) = fn

» Ml lesson plans

» (] Nature

¥ [ Plants

]
| -
=1
(=
|
|-
1
|-
|-
=]
(|
=1
|-

Agave.jpg
Bamboo Grove.jpg
Daisies.jpg
Dandelion.jpg
Fall Leaves.jpg
Crass Blades.jpg
Lavender.jpg
Leaf Curl.jpg
Leaves.jpg
Lotus.jpg
Maple.jpg
Peony.jpg
Petals.jpg
Purple Frond.jpg

Today, 3:30 PM

Jul 28, 2009 1:18 PM
Jul 28, 2009 1:18 PM
Jul 28, 2009 1:18 PM
Jul 28, 2009 1:18 PM
Jul 28, 2009 1:18 PM
Jul 28, 2009 1:18 PM
Jul 28, 2009 1:18 PM
Jul 28, 2009 1:18 PM
Jul 28, 2009 1:18 PM
Jul 28, 2009 1:18 PM
Jul 28, 2009 1:18 PM
Jul 28, 2009 1:18 PM
Jul 28, 2009 1:18 PM
Jul 28, 2009 1:18 PM

Dec 18, 2010 10:29 PM

Monday, February 21, 2011

Click on the Triangle to show the contents of a folder
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¥ DEVICES
.~ Macintosh HD

! Mac OS X Install DVD
E iDisk

¥ SHARED

Date Modified

I lesson plans
> Nature
= Plants

= Agave.jpg
= Bamboo Grove.jpg

Today, 3:11 PM

Dec 18, 2010 10:29 PM
Today, 3:30 PM

Jul 28, 2009 1:18 PM
Jul 28, 2009 1:18 PM

I MaraCapsule = Daisies.jpg Jul 28, 2009 1:18 PM

¥ PLACES = Dandelion.jpg
FA Desktop = Fall Leaves.jpg

Jul 28, 2009 1:18 PM
Jul 28, 2009 1:18 PM
7N teacherl = Grass Blades.jpg Jul 28, 2009 1:18 PM
A Applications Lavender.jpg Jul 28, 2009 1:18 PM
R Leaf Curl.jpg Jul 28, 2009 1:18 PM
Leaves.jpg Jul 28, 2009 1:18 PM

Vet Lotus.jpg Jul 28, 2009 1:18 PM
O Today Maple.jpg Jul 28, 2009 1:18 PM
L Yesterday Peony.jpg Jul 28, 2009 1:18 PM
(D) Past Week Petals.jpg Jul 28, 2009 1:18 PM

All Images Purple Frond.jpg Jul 28, 2009 1:18 PM
All Movies

Monday, February 21, 2011

Click plants
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DEVICES
| Macintosh HD

| Mac OS X Install DVD
= iDisk

SHARED

—J MaraCapsule

PLACES

E Desktop
Q teacherl

;Ag Applications

7/ Documents

SEARCH FOR Name A Date Modified '
(L) Today ] Plants Today, 3:30 PM O
(L) Yesterday = Agave.jpg Jul 28, 2009 1:18 PM 1.4
& =1 Bamboo Grove.jpg Jul 28, 2009 1:18 PM )

G All Images = Daisies.jpg Jul 28, 2009 1:18 PM 65,
N = Dandelion.jpg Jul 28, 2009 1:18 PM 14y
L] All Movies & - _—— -

1 of 20 selected, 124.76 GB available

Monday, February 21, 2011

Click Column View, you’ll be able to preview the pictures inside



¥ DEVICES
a Macintosh HD

=} Mac 05 X Install DVD
£ ibisk

¥ SHARED
—J MaraCapsule

lesson plans Nature Plants

¥ PLACES
Desktop

G} teacherl

ﬂ Applications
@ Documents

¥ SEARCH FOR
() Today
(L) Yesterday
(L) Past Week
All Images
All Movies

Monday, February 21, 2011
Click icon view again



Create New File
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) 3 = 4 @& Mon 8:26 PM teacherl p°!

Monday, February 21, 2011
Press Command-Space to show the Spotlight menu



~ | Show Al

® TexEd

Applications 7 TextEdit

' Parental Controls

Speech

') Language & Text
') Appearance

') Parental Controls

System Preferences |t}
D

Documents o Acknowledgements.rtf
Folders [ ] Textures

PDF Documents [% GarageBand Acknowledgem...
[%| Acknowledgements.pdf

Music [ig] Suspense Accents 07.caf
[ Suspense Accents 06.caf
Suspense Accents 05.caf
[ Suspense Accents 04.caf
[ Suspense Accents 03.caf
Suspense Accents 02.caf
[ Suspense Accents O1.caf
B Super Stager.caf

Fonts |1 Hoefler Text.ttc
') Hoefler Text Ornaments.ttf

Spotlight Preferences...

Monday, February 21, 2011

Type in t e X and TextEdit should be displayed as the Top Hit, press Return



Monday, February 21, 2011
TextEdit launches. You'll see a blue light under the TextEdit icon.



Monday, February 21, 2011

If you click and hold on TextEdit then you will see a menu, choose Keep in Dock so that the
TextEdit icon is always in the Dock



® N O Untitled

(Styles o) (&= = =) (Spacing Iwj [Lists | » e 4o
7')'}')')')'}')')'}')'l}')'I' ——
o™ " 2 lg " 7 g ° g~ ° l10 l12 l14 |

My trip to Japan

Monday, February 21, 2011

Type in a few sentences. You can try the following keyboard shortcuts.

Command-X Cut

Command-V Paste
Command-C Copy
delete Backspace

fn-delete Delete



Monday, February 21, 2011

Click on the Desktop and locate the my stuff folder



¥ DEVICES
a Macintosh HD

=} Mac 05 X Install DVD
£ ibisk

¥ SHARED
—J MaraCapsule

lesson plans Nature Plants

¥ PLACES
Desktop

G} teacherl

ﬂ Applications
@ Documents

¥ SEARCH FOR
() Today
(L) Yesterday
(L) Past Week
All Images
All Movies

Monday, February 21, 2011

Open the my stuff folder



¥ DEVICES
.~ Macintosh HD

| Mac OS X Install DVD
E iDisk

¥ SHARED
— MaraCapsule

¥ PLACES
E Desktop

m teacherl

ﬁ Applications
Documents

¥ SEARCH FOR
(L) Today
() Yesterday
() Past Week
All Images
All Movies

Aurora.jpg Clown Fish.jpg

Zi B e

Earth.jpg Evening

Reflections.jpg
= L
Golden Palace.jpg

Horizon.jpg
Leopard Aurora.jpg

Pond Reeds.jpg

Cirques.jpg

Earth Horizon.jpg

‘
-— .
\

Gentle Rapids.jpg

Ladybug.jpg

Dew Drop.jpg

Flowing Rock.jpg

@

Iceberg.jpg

Rock Garden.jpg

Monday, February 21, 2011
Open the nature folder




ile_ Edit

Format Window Hel

P ~ ~~

.| Nature
Untitled , © | |8~
[ Styles ;} [E' = Ew ' Spacing ;J ' Lists '7] P ¢ 40 Cirques.jpg
>
MytriptoJapan
r
e
Earth.jpg

B

Golden Palace.jpg

\‘

Leopard Aurora.jpg

, b selected, 124.76 GB availabl

Monday, February 21, 2011
Drag a picture from the Nature folder into the TextEdit document



Save New File
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New
Open...
Open Recent

Close

Save

Save As...

Save As PDF...
Save All

Revert to Saved

Attach Files...
Show Properties

Page Setup...
Print...

0 3A
3P

{r36P
kP

Monday, February 21, 2011
Choose Save from the File menu



=1 * . . R

| . — B — I
] Save As: Untitled

7 Where: [ Documents bﬂ

File Format: | Rich Text Format with Attachments |4 |

| CCancel) (D) \

Monday, February 21, 2011
Change the name to lesson plan 1



Monday, February 21, 2011
Click on the black triangle in the blue box to expand it



Save As: lesson plan 1

(] Plants ™

[4 >}[SS = m| [E;llessonplans
o ~ [ my stuff -
¥ SHARED “ renamer (] Nature
t— MaraCapsule “ Screen sh...26.30 PM
“| Screen sh...27.03 PM
fﬁ —— “ Screen sh...27.43 PM
f\Ap R “| Screen sh...28.29 PM -
7xnep “ Screensh...29.28PM |4
"} Documents | [%] screen sh...29.39 PM M

]
¥ SEARCH FOR v éﬂﬁﬂ.—.....__....__; e e P

File Format: [ Rich Text Format with Attachments .-ﬂ

™ Hide extension ( New Folder )

( Cancel ) ( Save )

/.

Monday, February 21, 2011

Choose Desktop, then click my stuff, then click lesson plans

Click Save



¥ DEVICES
a Macintosh HD

=} Mac 05 X Install DVD
£ ibisk

¥ SHARED
—J MaraCapsule

lesson plans Nature Plants

¥ PLACES
Desktop

G} teacherl

ﬂ Applications
@ Documents

¥ SEARCH FOR
() Today
(L) Yesterday
(L) Past Week
All Images
All Movies

Monday, February 21, 2011
Open the lesson plans folder



a Macintosh HD
=} Mac 05 X Install DVD

£ ibisk

¥ SHARED
—J MaraCapsule

lesson plan 1

¥ PLACES
Desktop

&8 teacherl

ﬁ Applications
@ Documents

¥ SEARCH FOR
() Today
(L) Yesterday
() Past Week
All Images
All Movies

Monday, February 21, 2011
You can see the file there



. lesson plan 1 I__{ KE-2d Q

fz—'—'—' My trip to Japan

AT RPN W e
R T

Monday, February 21, 2011

click on the file (don’t double click) and press space bar to preview it. this is called Quick
Look



& Ll L[y File Edit Fo

About TextEdit l
Preferences... 88, -
@
Services [
>

Hide TextEdit 3H |
Hide Others " &H

S‘f\ (:'.\v'\“ ,A\ !

Quit TextEdit 38Q

Monday, February 21, 2011
Choose Quit from the TextEdit menu



Arrange Files
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Go Window Help

HE

Clean Up
Arrange By

rrrrrrrrr

Show View Options 88}

Monday, February 21, 2011
Close all windows. Choose Show View Options from the View menu.



Finder File Edit View Go W
r R Desktop.

Icon size: 92 x 92
A o (%) b | 24

Crid spacing:

@rl | I IVII

s

Text size: | 12 v

Label position:
® Bottom () Right

() Show item info
@ Show icon preview

Arrange by ¥ None

Snap to Grid

Name
Date Modified
Date Created
Size

Label

Monday, February 21, 2011
In the Arrange by pop up menu, choose Kind. You can change other parameters as well.



Find Files
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} 2 9 @& Mon9:09PM teacherl J5

Monday, February 21, 2011
Press Command-Space to enable Spotlight



| Show All

@ lesson plans
Documents ' lesson plan 1

Folders [_] lesson plans

Spotlight Preferences...

Monday, February 21, 2011

Search for lesson plan
It will be displayed while you are typing the name



$ = <) @I Mon 9:10 PM

| Show All

Documents | @ lesson plan 1

Spotlight Preferences...

Monday, February 21, 2011

If you type in the words in that document, it will display the file

Click Show all



¥ DEVICES Search: “teacher1” | File Name
.~ Macintosh HD

.~ Mac OS X Install DVD
£ ibisk

¥ SHARED
— MaraCapsule

Name Last Opened
B lesson plan 1 Rich T...ments Today, 8:33 PM

¥ PLACES
Desktop
@ teacherl

ﬁ Applications
@ Documents

¥ SEARCH FOR
() Today
(L) Yesterday
() Past Week
All Images
All Movies

!
!
4
!
!
4
!
!
4
!
!
4
!
!
4
!
!
4

Monday, February 21, 2011
Click the file to show it’s location



Copy to thumbdrive
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teacherl Q

TRANSCEND

Monday, February 21, 2011

Plug in thumbdrive, it will appear on the Desktop



E Macintosh HD
= Mac 05 X Install DVD

E ipisk
__ TRANSCEND lesson plan 1

¥ SHARED
— MaraCapsule

¥ PLACES

Desktop
ﬁ teacherl

ﬁ Applications
@ Documents

¥ SEARCH FOR
() Today
(L) Yesterday
(L) Past Week

All Images

Monday, February 21, 2011
Open lesson plans folder and click on lesson plan 1



ler

[T

Edit View Go Window Help

New Finder Window
New Folder

New Smart Folder
New Burn Folder
Open

Open With

Print

Close Window

Get Info
Compress “lesson plan 17

Duplicate
Make Alias
Quick Look "lesson plan 1"

—~

EW
&

#&D
A
#BY

. -

f PLAC
N e

o

Monday, February 21, 2011
Choose Duplicate from File menu



o I
—
lesson p

RTFD

lesson plan 1 cop

Monday, February 21, 2011
A duplicate is created



‘U % = 4 @ Mon 9:18 PM teacherl Q

a Q

v

TRANSCEND

Iessonq

lesson plan 1 copy
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Drag the duplicate into your thumbdrive
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Double-click on thumbdrive to show the file inside
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Right-click thumbdrive and choose Eject, then pull out the thumbdrive



Delete files
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Monday, February 21, 2011
Find the duplicate lesson plan in the lesson plans folder
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Drag it to the Trash
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Choose Empty Trash from the Finder menu
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If you put things into the Trash by accident, click Trash and drag it back out



Install Printer
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Download Center for CLP-510N

Manuals Driver Software
eeeAllees v
oS ReleaseDate Description Size (MB) Language Flle
MacOS 103 ~10.5 Oct 7, 2009 Print Driver (Driver) (ver.1.07 0.83 MULTI LANGUAGE Vi
Mac OS 106 Oct 6, 2009 Print Driver (Driver) (ver.3.00 3.86 MULTI LANGUAGE 2
. Print Driver,(Add Printer) (Driver)

‘ er) /er) - £
2000/XP/2003/Vista/2008/WinOct 31, 2008 . ' 12.83 MULTI LANGUAGE (Z1F)
7 (ver.3.04.25) 14
Win rsal | t Dr )r

Universal Pnnt Driver (Driver X
2000/XP/2003/Vista/2008/WinApr 2, 2010 e 1 P | 20.66 MULTI LANGUAGE @
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Win 98/MER2K/XP/2003 Apr 2, 2007 Print Driver,GDI (Driver) (ver.2.32) 15.39 MULTI LANGUAGE @
Win 98/MER2K/XP/2003 Oct 31, 2008 Status monitor (Driver) (ver.1.31) 56.36 MULTI LANGUAGE @
Win Vista/2008/Win 7 Oct 20, 2009 Print Driver,GDI (Driver) (ver. 3.03.01:02) 30.04 MULTI LANGUAGE @
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The Mac can autodetect most printers, but if your printer doesn’t work you will need to
download the driver from the Internet first
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Wait for the download to complete
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Click Downloads in the Dock, you will see the printer driver there. Click it.
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Click Open
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Type in your admin username and password, and click OK
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Click Continue
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Wait until installation completes



Finish Up
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Click Quit
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Open the file you want to print
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Here we are using the lesson plan 1 file
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Choose Print from the File menu
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If you see No Printer Selected click Add Printer...
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Choose the printer and click Add
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Click Print (Click the blue box with the black triangle inside to see advanced print options)
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When printing starts you will see the Print Queue in the Dock. Click it.



Printer Ready

' Completed
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Shows you printer status and jobs waiting to be printed.



